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Welcome To Yummy FTP!

Yummy FTP is an FTP (File Transfer Protocol) and SFTP (Secure File Transfer Protocol) client
application, lovingly crafted by Mac devotees specifically for Mac OS X. Its primary purpose
is for uploading and downloading files and folders using servers which support the FTP or
SFTP protocols. However, in addition to this basic functionality, Yummy FTP brings a
wealth of advanced features which provide the ultimate in convenience, reliability, and
powerful ease of use when working with all your file transfer needs. All this comes
wrapped up in a beautifully elegant Metal or Aqua user interface.

How To Purchase

Yummy FTP costs $25 for a single user license, and can be purchased online either directly
from within the application itself or via our web store. Online purchase and registration is
handled by eSellerate. For more information about the secure online eSellerate purchase,
please visit

http://www.esellerate.net/security.asp    

To purchase the software from within the application itself, choose Purchase Online from
the Yummy FTP menu and follow the on-screen instructions. The process is secure, quick
and easy. Your registration will be processed immediately.

To purchase the software from our web store, please visit

http://store.eSellerate.net/s.asp?s=STR8473489846    

Either way, all major credit or debit cards are accepted.

For site license enquiries, multi-user purchase discounts, educational and non-profit
organisation discounts, or PayPal payment enquiries, which we also accept, please contact
our sales team at:

mailto:sales@yummysoftware.com     

http://www.esellerate.net/security.asp
http://store.eSellerate.net/s.asp?s=STR8473489846
mailto:sales@yummysoftware.com


Completed Purchase

Once a purchase has been processed, an email will be sent which contains a Name and
Serial Number, which will unlock the demo version of Yummy FTP and convert it to a full,
registered copy.

If Yummy FTP was purchased using the Purchase Online option within the software then
this information is entered automatically and there is no need to wait for the email.
However, if a purchase was made using our webstore, or Yummy FTP needs to be re-
installed at any time, select the Enter Serial Number option from the Yummy FTP menu and
enter the registration details.

Feedback

We want to hear what you think of Yummy FTP. If you have any comments, suggestions or
requests, please let us know. Send your email to:

mailto:feedback@yummysoftware.com     

mailto:feedback@yummysoftware.com


License Agreement

This Limited Use Software License Agreement (the "Agreement") is a legal agreement
between you ("Licensee"), the end-user,  and Yummy Software ("Producer") for the use of
the Yummy FTP software product ("Software")

•  By installing, or using this Software or storing this program on a computer hard drive
(or other media), you are agreeing to be  bound by the terms of this Agreement

•  If you do not agree to the terms of this Agreement, promptly delete the Software from
all storage media.

• You accept responsibility for any network usage costs or any other costs incurred by
using this software

•  NO WARRANTIES:  - Yummy Software EXPRESSLY DISCLAIMS ANY WARRANTY for the
SOFTWARE. The  SOFTWARE and any related documentation is provided "as is" without
warranty of any kind, either express or implied,  including, without limitation, the implied
warranties of merchantability, fitness for a particular purpose, or no infringement

•  The Producer does not warrant that the functions of the SOFTWARE will meet your
requirements or that the operation of the  SOFTWARE will be uninterrupted or error free.
You assume responsibility for selecting the SOFTWARE to achieve your  intended results,
and for the use and the results obtained from the SOFTWARE

•  NO LIABILITY FOR DAMAGES. In no event shall Yummy Software or its suppliers be liable
for any direct,  indirect, consequential or incidental damages whatsoever (including,
without limitation, damages for loss of business profits,  business interruption, loss of
business information, or any other pecuniary loss) arising out of the use of or inability to
use this  SOFTWARE, EVEN IF PRODUCER OF THIS SOFTWARE HAS BEEN ADVISED OF THE
POSSIBILITY OF SUCH DAMAGES.

Copyright

•  Yummy FTP is Copyright 2006, Yummy Software.  You must treat the Software like any
other copyrighted material.
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Opening Connections
Making A New Connection

To establish a connection with a Server for the first time, select 'New Connection' from the
'File' menu to display the New Connection window if it is not already shown.

New Connection Window

• Into the Server field, enter the name or IP address of the FTP or SFTP Server you
want to connect to. For example, ftp.apple.com

• Into the Username field, enter the username you were given by the administrator of
the FTP or SFTP Server you want to connect to. If you are accessing a public Server,
such as ftp.apple.com, you will use what is known as anonymous FTP, and you should
leave the field blank.

• Into the Password field, enter the password you were given by the administrator of
the FTP or SFTP Server you want to connect to. Again, if you are accessing a public
Server, such as ftp.apple.com, you will use what is known as anonymous FTP, and you
should leave the field blank.

These settings should be sufficient for most users when connecting to standard FTP
servers. Pressing the Connect button at this point will establish a connection with the
specified FTP server.

For advanced users, press the blue disclosure button at the bottom left of the window
to show additional options that can be chosen:



Advanced Settings

• The Initial Path field may be left blank, unless you require a specific directory
listing to be displayed when you connect to the Server.

• The Port field should be left untouched unless the Server you are connecting to
uses a non-standard port number. As standard, FTP uses a port number of 21 and
SFTP port 22.

• From the Protocol menu choose the type of Server protocol to use - either Standard
FTP, Secure FTP using SSL/TLS/Implicit SSL or Secure SFTP. Standard FTP is most
commonly used.

• If you are connecting using SFTP, you may use Public Key Authentication by
enabling the SSH key checkbox and selecting your keyfile by pressing the Select
button and navigating to your file. If keys are configured in your ssh_config file, this
will be automatically recognized. If the Protocol is not set to SFTP, this setting will
have no effect.

• The Compression checkbox applies only to SFTP connections and enables on-the-
fly compression and decompression of transferred data to produce faster transfers

You may click on one of the two popup menu buttons to select the details of a recent
connection or a Server discovered using Rendezvous/Bonjour.

When you have entered all the required details, press the Connect button to initiate a
connection with the Server.



Connecting

The connection attempt can be cancelled by pressing the  button.

If a connection is successfully established, an FTP Browser window will be displayed
and you can start browsing directories and transferring files. See the Transferring
Files/Folders section for further details.

To disconnect from a server, simply close the FTP Browser window. Alternatively, if
you require the FTP Browser to remain open for later reconnection, you may select the
'Disconnect' option from the Toolbar icon or the 'Transfer' menu. Re-connection is
automatic when an action is performed on the server.

If the connection attempt fails, the reason will be displayed in an alert and dismissing
this will close the connection window. You should review the settings in the New
Connection window to ensure all the details are correct and then try again.



Connecting To A Server Again

To establish a connection with a Server which you have connected with before, there are
two options.

Recent Connections Menu

Use the 'Recent Connections' option in the 'Bookmarks' menu and select the entry
which shows the Server you require. When an entry is selected a connection to the
Server will be established immediately. It may be necessary to enter the Server
password each time a connection is established this way.

The Recent Connections menu is also available within the New Connection window.
Selecting an entry from the menu will fill the New Connection window fields with the
details of the selected recent connection. The details can then be modified, if
required, prior to establishing the connection.

Bookmarks

When a new connection to a Server is established, you can save the connection details
as a Bookmark. A Bookmark can be created at any time when an FTP Browser window
or the New Connection window is active by selecting 'Add Bookmark' from the
'Bookmarks' menu.

Bookmark files are stored in your Preferences folder and can be accessed either by
using the Bookmark Viewer or the Finder. To open the Bookmark Viewer, select the
'Show All Bookmarks' option from the 'Bookmarks' menu.



Bookmarks Viewer

To establish a connection using a previously saved Bookmark, double click on its
name in the Bookmarks Viewer, or select it and then press the Connect icon in the
Toolbar.

To establish a connection using a Bookmark file in the Finder, simply double click on
the Bookmark icon.

To establish a connection using the 'Bookmarks' menu, simply select the Bookmark
name from the list shown.

The Bookmark Viewer also allows you to organize Bookmarks, edit, create or delete
them and also allow the import of Bookmarks from other FTP applications, by simply
dragging them onto the Bookmarks Viewer.

Bookmark files can be copied to any location on your Mac, but they will only appear in
the Bookmark Viewer if located in your Preferences folder. Bookmarks are stored
inside a Bookmarks folder which is inside a Yummy FTP folder.



Transferring Files/Folders
Yummy FTP provides many methods of file/folder transfer. The most commonly used are
from within the FTP Browser window, via FTP Aliases and also URLs from other applications
such as a web browser.

FTP Browser Window

An FTP Browser window will only be displayed once a successful connection has been
established with a Server.

FTP Browser

By default, FTP Browser windows show the files and folders on your Mac on the left
and the Server files and folders on the right. The Mac browser can be completely
hidden, if preferred, by dragging the divider between the two browsers all the way to
the left.

To transfer items between your Mac and the Server, or vice versa, simply select the
items and then drag them to the required location, just as you would in the Finder.
You may also drag and drop between the Finder and Yummy FTP, which is necessary
if the Mac browser is hidden. Alternatively, you can use the Toolbar upload/download



icon or the 'Upload/Download' option in the 'Transfer' menu to transfer whatever is
currently selected to the opposite browser.

Since the FTP Browsers are designed to behave almost identically to the Finder, all the
usual functionality is supported:

• Items can be moved around within the same browser by selecting the items to be
moved, then drag and dropping them to the required folder.
• Items can be renamed by clicking in their displayed name and editing the text.
• Items can be deleted by dragging them to the Trash icon within your Dock or the
convenient Trash icon in the FTP Browser window itself, if configured to show.
• Lists can be sorted by any of the displayed types (Name, Date, Size, Kind, etc) by
simply clicking in the required column header.
• List columns can be resized by clicking at their extreme right and dragging the
mouse.
• List columns can be rearranged by clicking on their column headers and dragging
them with the mouse.

Yummy FTP also supports Column view which again works in a similar manner to the
Finder:

Column View



Server To Server Transfers

Yummy FTP supports transferring files/folders between two different servers. To do this
you must have an FTP Browser window open for each of the servers. Simply drag and drop
the items to be transferred from the sender server's FTP Browser window to the
destination server's FTP Browser window.

Currently Yummy FTP does not support FXP (File eXchange Protocol) for these operations,
although there are plans to include this in a later version. Instead, the items are
downloaded to your Mac and then uploaded to the destination server.

Batch, Scheduled and Repeating Transfers

To select a number of transfers to be executed at a later time, simply select the required
items in the FTP Browser window and drag them to the Queue drawer. Alternatively, you
may select the 'Download Later' or 'Upload Later' menu options - the items will still appear
in the Queue drawer.



Queue Drawer

To show the Queue drawer, select 'Show Queue Drawer' from the 'View' menu, or click
the  button at the bottom of the FTP Browser window.

To start the transfers, select them in the Queue drawer list and then press the 
button in the Queue drawer window. The transfers can be cancelled by pressing the

 button.

To schedule waiting transfers to take place at a later time, and/or repeat the transfers
periodically, select the required items and then press the  button.



FTP Aliases
An FTP Alias works like any other alias to a folder in the Finder would. The difference is
that the folder represented is that of an FTP Server directory. Double clicking an FTP Alias
will display the contents of the Server directory. Dragging and dropping files/folders from
the Finder or other applications onto an FTP Alias will copy them to the Server directory.

Drag & Drop in the Finder to an FTP Alias

To create an FTP Alias you must have a connection established with the desired
Server and an FTP Browser window displayed for it.

Navigate to the desired Server directory in the FTP Browser, and then select 'Save as
FTP Alias' from the 'File' menu, or select the same option from the contextual menu.

Note that if a folder item is selected in the Server directory, the FTP Alias will
represent contents of that directory and not of the directory currently listed.

Special Note: FTP Aliases will inherit whatever connection settings have been applied
to the FTP Browser and Bookmark, if any.  For example, if Binary transfers are
selected rather than Automatic then this will be set in the FTP Alias also. Since a
warning will be displayed, by default,  if a file to be uploaded already exists on the
server, you may prefer to set the 'Always Replace Files' option in the ' Transfer - Mode'
menu  prior to creating the FTP Alias.

You may create an FTP Alias at any location on your Mac, but the Desktop is the most
useful place.

An FTP Alias can be edited by selecting 'Edit' when no Bookmarks are selected in the



Bookmarks Viewer window. A navigation window will be displayed in order to allow
you to select the FTP Alias file.

FTP Aliases can be copied to another Mac, so long as Yummy FTP is installed there
too.



FTP Watcher

An FTP Watcher is equivalent to a Finder Folder Action for FTP uploads. When an FTP
Watcher is placed in a folder on your Mac and double clicked, it monitors the folder for
new files and/or folders being added to it. As soon as new items appear they are
automatically uploaded to a pre-defined Server and destination directory of your choice.

Two varieties of FTP Watcher are available - Upload Watcher and Archive Watcher. Upload
Watcher uploads new or changed files/folders only. Archive Watcher uploads new items
only, then archives the items to a date and time stamped folder.

FTP Watcher

To create an FTP Watcher you must have a connection established with the desired
Server and an FTP Browser window displayed for it.

Navigate to the desired Server directory in the FTP Browser, and then select 'Save as
FTP Watcher' from the 'File' menu, or select the same option from the contextual menu.

Note that if a folder item is selected in the Server directory, the FTP Watcher will
upload to that directory and not to the directory currently listed.

Special note: FTP Watchers will inherit whatever connection settings have been
applied to the FTP Browser and Bookmark, if any.  For example, if Binary transfers are
selected rather than Automatic then this will be set in the FTP Watcher also. Since a
warning will be displayed, by default,  if a file to be uploaded already exists on the
server, we recommend setting the 'Always Replace Files' option in the ' Transfer - Mode'
menu prior to creating the FTP Watcher.

Once selected, an icon as displayed above, will be created in the location of your
choice.

You must ensure that FTP Watcher is located in the same folder as the files/folder



that will be put there to be uploaded, otherwise a lot of unwanted items could be
uploaded by mistake.

Double click the FTP Watcher icon to start it. There will be a visual confirmation when
the Watcher is ready.

As items appear in the 'watched' folder, the FTP Watcher will see them and start to
upload them.

For the Archive Watcher, whilst items are transferred, they are temporarily stored
within a Processing folder, which resides within a folder named as the current date
and time. When the uploading is complete, the items are moved from the Processing
folder into the date and time folder, and the Processing folder is deleted. All these
folders reside within a folder named Yummy FTP Watcher History that the FTP
Watcher creates when it is started for the first time. The Yummy FTP Watcher History
folder therefore provides a useful resource for auditing purposes.

To stop FTP Watchers, select the 'Stop All FTP Watchers' option in the Transfer menu
of Yummy FTP.

An FTP Watcher can be edited by selecting 'Edit' when no Bookmarks are selected in
the Bookmarks Viewer window. A navigation window will be displayed in order to
allow you to select the FTP Watcher file.

FTP Watchers can be copied to another Mac, so long as Yummy FTP is installed there
too.



URLs

ftp://username      :password@ftp.Servername.com:21/initial path    

A URL (a standard to represent a location, folder or file on the Internet, such as above) can
be processed by Yummy FTP. This can be especially useful when FTP link URLs are
specified on web sites or emails.

By pasting the URL onto the New Connection window, the fields in the window will be filled
with the contents of the URL. Pressing Connect will then process the URL and either
display the Server directory or download the Server file, as described by the URL.

ftp://username
mailto:assword@ftp.Servername.com:21/initial


Previewing Files
Images, text files, movies, mp3s and just about any kind of file can be viewed within
Yummy FTP's Preview drawer which can be displayed by pressing  the button in the FTP
Browser window:

Preview Drawer - Info

When the Preview drawer is opened the button changes to a  and pressing it will
close the Preview drawer again. The drawer will show information about the selected
item, if any.

Pressing the  button will display the Info window for the selected item, where
access permissions and ownership can be changed.
Pressing the  button will cause the selected file to be previewed within the drawer,
such as shown below:



Preview Drawer – Viewer

Pressing the  button will cancel the displayed preview and revert to the information
display shown previously.

If the Auto checkbox is enabled, Yummy FTP will automatically display a preview of
each file as it is selected in the list. When Auto-preview mode is enabled, there will be
a  button in place of the cancel button and pressing this button will cause the
displayed preview to be refreshed, fetching new data from the server if necessary.
Un-checking the Auto checkbox again will revert to normal behavior.

When an image preview  is displayed, such as a .jpg or .pdf file, clicking on the
preview image itself will display a full screen preview so that the image can be seen
without scaling. To dismiss the full screen preview simply click the mouse.



Modifying Permissions And
Ownership
Advanced users may need to modify the access permissions and owner/group settings of
files and folders. These settings can be adjusted for server items within Yummy FTP. For
items on your Mac, the Finder is recommended

Get Info

To display and modify the permissions and/or ownership of items, select them in the
Server directory listing and then either press the 'Info' Toolbar icon, select 'Get Info'
from the 'File' or contextual menu, or select 'Info' from the Action button within the
FTP Browser window.

Get Info Window

The chosen permissions and ownership settings can be applied separately or at the
same time to single or multiple items. Additionally, the settings can be applied to
only folders, only files, or both. In the case of folders, it is possible to drill down into
each sub folder, adjusting the settings for all the files/folders within, by selecting the
'Recursive' checkbox.

Note that the 'Owner' and 'Group' settings can be specified numerically or by name. A
list of names that have been supplied by the server are available from the popup



buttons next to each each field. Also, owner and group settings are only available
during SFTP sessions.

It is also possible to set permissions automatically while uploading files. To configure
this, select the 'Server Options' tab of the Preferences window, enable the 'Set
permissions of uploaded files' checkbox and configure the permission settings you
require. This is currently a global setting which affects all connections.



Editing Files
Files on your Mac or on the Server you are connected to can be edited directly, using a text
editor of your choice. This can be especially useful for modifying web site pages.

For your convenience, Yummy FTP includes a simple built-in text editor which is available
from the 'QuickEdit' menu item or Toolbar icon.

The default third party editor that is set by default in Yummy FTP is TextWrangler by
BareBones software. It is a free but powerful text editor and it can be downloaded here:

http://www.barebones.com/products/textwrangler/download.shtml   

To change the default editor, select the 'Preferences' option from the 'Yummy FTP' menu
and select the 'Server Options' tab. Within that tab is an area where pre-configured
editors, such as SubEthaEdit, BBEdit, TextMate and others can be chosen, or any other
application can be selected by picking the 'Other' option.

Whichever editor is chosen as the default editor, you can configure as many additional
editors as you need by selecting the 'Edit With...' option from the 'File' menu or contextual
menu. Each editor application you choose after selecting this option is remembered by
Yummy FTP so that you can quickly edit with your chosen alternative editors for future
sessions.

The last editing setting that can be configured is perhaps the most powerful. An editor of
your choice can be selected for each type of file. For example, Graphic Converter for image
files, TextWrangler for text files and so on. The settings for this are within the Suffix
Mapping table, which is described later in this Quick Start Guide, but essentially, each file
name suffix (e.g .txt, .jpg, etc) can be associated with an editor application. Each time an
edit is started for which the file name has a suffix with an editor application specified, that
setting will take precedence over the default editor configured in the Preferences.

Edit

To edit one or more files, select them in the Mac or Server browser, as required, and
then press the Edit icon in the Toolbar, or select 'Edit' from the 'File' menu or
contextual menu. Alternatively, the 'Edit With...' or 'QuickEdit' options can be chosen.

http://www.barebones.com/products/textwrangler/download.shtml


Editing Using QuickEdit

When a file on a Server is edited, the file is downloaded to your Mac and then opened
in the editor of your choice. When changes have been made to the file and the
changes are saved or the file is closed, the file is automatically uploaded back to the
Server, overwriting the original.

If no file is selected in the chosen browser, selecting the Edit option will allow an
empty file to be created and then opened immediately in the editor. If a single folder
is selected, a new file can be created within it.

Once an edit has been started, the FTP Browser window can be closed, if required.
Files that are being edited on a Server will still be updated when saved or closed.

A Note About Some Editors

Yummy FTP works best for remote editing when the editor application is ODB-aware.
ODB is a protocol which allows applications to 'talk' to eachother. Applications such
as TextWrangler, BBEdit and TextMate are ODB-aware.

Most applications do not support the ODB protocol, and for this reason it is not
possible for Yummy FTP to know when you have finished your remote editing session,
even though it can always detect that the edited files have changed and send them
back to the server. For this reason, when quitting Yummy FTP you might be warned
that remote editing documents are still open. This is because Yummy FTP only knows
that the editor application is still running.



Synchronizing Local & Remote Files
and Folders
The most common use of synchronization is to maintain a local copy of a web site, so that
changes made at the Server or locally on your Mac will always be kept up to date with its
mirror.

To start a synchronization, you must have a connection established to the required Server
and the FTP Browser window showing.

You should then navigate to the Mac and Server directories to be synchronized, and then
press the Synchronize button in the Toolbar, or select the 'Synchronize' option in the
'Transfer' menu.

Before You Synchronize

Since the synchronization feature can automatically replace or remove files, both on
your Mac and on the Server, it is potentially dangerous if used incorrectly. We highly
recommended that a test be made before proceeding with a synchronization using
real files, so that you may familiarize yourself with the functionality. The Preview
option provided is ideal for this purpose, since it will go though the entire
synchronization process and display a list of changed files/folders, prior to them
actually being transferred. The synchronization can then be aborted or allowed to
continue.



Preparing A Synchronize

Before a synchronization can commence, you should study the options available and
decide which are best for your particular situation. For most users, the default
settings should work.

Starting A Server Update

Firstly, choose which method of synchronization should be used. The most common
setting is Update Server, which will transfer newer files from the copy of your website
on your Mac to the Server. Whatever the selection, the Synchronize window will
describe what will be performed depending upon the choice you make.

Decide which method Yummy FTP should use to determine which files are newer on
the Server or your Mac. There are two methods by which Yummy FTP can do this:

Latest modification date -  This compares the Date Modified values in the Mac and
Server files and the files with newer modification dates are transferred.

This method relies on the clock in your Mac and the clock on your Server being in



sync - the same time. If the Server is in a different time zone, then it is crucial that
the Server time difference is set and set correctly.

Unless you are certain of the exact time difference, enable the 'Automatically detect
time offset' check box. This will determine the time difference between your Mac and
your Server by uploading a small file to the Server and noting the time on your Mac
when the upload completes. By then examining the Date Modified value displayed by
the Server, the difference between this time and the upload completion time noted
previously is the Server time difference. The test file will be deleted when the
detection is complete.

Differing sizes -  This option is only available for Update Server and Update Mac. It
compares the sizes of the Mac and Server files and transfers files which do not have
matching sizes

Although this method is simpler to use than the date comparison method because
there is no Server time difference to worry about, it can be less reliable because a file
can change its contents completely and yet remain the same size. In this case it is
impossible to determine that the file has changed.

The default setting is to use date comparison since this is usually the most reliable,
so if you are unsure, use this. Either way, if one method does not produce the results
you expected with your particular server, try the other.

Optional Settings

If you require an Update Mac or Update Server synchronization to produce an exact
copy of the source files and folders at the destination, the following setting will be
needed:

Delete orphaned items - This option is disabled by default because it causes
items to be deleted at the destination. An orphaned item is a file or folder which
exists in the destination but not in the source, where the source and destination
are your Mac and the Server (for Update Server) or the Server and your Mac (for
Update Mac). This option is unavailable during a Mirror.

In some situations it is desirable to discount certain files and or folders from the
synchronization process. There are two ways of achieving this for different situations:

Process sub-directories - This option is enabled by default. If you require only
the contents of the top-level directory to be synchronized, ignoring all the
directories within it, disable this option



Filters - For more advanced cloaking capabilities, use the Filters window to
specify exactly what should be included or excluded from synchronizations. The
Filters window is available by selecting 'Filters' from the 'Listing' menu. You must
configure this separately from the Synchronization window. See the Filters
section in this Quick Start Guide for more details.

When date comparison is set as the method to determine newer files, Yummy FTP will
compare the sizes of files when their dates are exactly the same. If the sizes differ,
Yummy FTP will consider that one of the files has changed and transfer one according
to the direction of synchronization - for an Update Server the Mac file would be
uploaded. This behavior can be disabled with the following option:

Compare sizes if dates match - This setting is on by default. However, in some
situations, although the data of two files may be identical, the storage format on
the server can cause the sizes to be different despite the files actually being
identical. In this case Yummy FTP would erroneously transfer what it considers to
be the 'newer' file. Disable this option to cater for this type of scenario.

To enable you to troubleshoot synchronizations, the Preview option can be used.
This will display a report of all the items which would be transferred/deleted if the
synchronization was to take place. You then have to options to abort the
synchronization completely, continue with the listed actions or individually
add/remove items from the list shown before commencing with the synchronization.

To further enable you to troubleshoot synchronizations, the Enable diagnostics
option can be used. This will report in the FTP transcript the reasons why each
file/folder are synchronized. The 'Log all connections' option in the Transfers tab of the
Preferences must normally be enabled for this feature to work.



Running A Synchronize

When you are completely satisfied that the synchronization is correctly configured,
press the Synchronize button, or the Preview button, if the preview mode has been
selected.

The Synchronize feature will first analyze both the Mac and Server directories to build
a list of files and folders to upload, download, or delete, depending on the settings
you have selected

For large directories, the analysis stage may appear to take an extraordinarily long
time. This is nothing to be concerned about - the majority of time spent during the
analysis stage is for fetching directory listings from the server, which would have to
be done in any case during the subsequent transfers. Yummy FTP does not re-fetch
the directory listings when it starts to transfer because it already has them cached.

When comparison is complete the necessary transactions will be performed. A
progress bar and the approximate time until completion will be displayed.

When the synchronization has completed a report will be shown to give an indication
of what was transferred.

Synchronization Report



Scheduling A Synchronize

Yummy FTP provides a means to automatically synchronize once at specific time and
optionally to repeat the synchronization at certain intervals. This has a wide range of
uses. For example, a server could be update once a day at 1am.

To configure.a scheduled synchronization, set up the synchronization as would be
suitable for immediate processing, but press the Schedule button when ready.

Schedule

When you have configured the schedule as required, press the OK button. Then press
the Run Schedule button in the Synchronization window. The scheduled
synchronization will be added to the Queue drawer, awaiting execution:



Running Schedule

To remove the scheduled synchronization, simply select it in the Queue drawer list
and press the  button.

To reconfigure the schedule or synchronization settings, select the entry in the Queue
drawer list and press the  button.

To start the scheduled synchronization immediately, select it in the Queue drawer list
and press the  button.

You may configure as many scheduled synchronizations as your require. Each one has
its settings and last date and time of synchronization stored in the Bookmark with
which it was created.

If you close the FTP Browser window, the scheduled synchronization will still take
place automatically, so long as Yummy FTP remains running.



Filters
Yummy FTP allows you to omit or include certain items during transfers, synchronizations
and even normal browsing activity. There are many uses for filters, most notably for
automation purposes during AppleScript driven transactions and for cloaking purposes
during synchronizations.

Setting Up Filters

Select the 'Filters' option from the 'Listing' menu or click the Filters Toolbar icon to
display the Filters window.

Server Filters

Separate filters can be applied to both the Mac and Server and they can be configured
by clicking the Mac Filters or Server Filters tab respectively.

The filters operate using a logical And / Or mechanism, with filtering by name, date
and type. Each filter entry can be negative or positive, for example 'Name is' and
'Name is not', and can be applied with case sensitivity included or ignored.
Additionaly. folders can be optionally omitted from each filter entry.

Filters can be added by pressing the + button and removed with the - button.

The entire filter set can be enabled/disabled by means of the 'Include items whose:'
checkbox. Your filters will remain inactive but intact even if this setting is off.



Once the filters are configured, you may specify whether they apply to Browsing,
Transfers or Synchronizations by means of the checkboxes provided. When the
Browsing checkbox is off, items which would be filtered for transfers of
synchronizations will be shown in red in your FTP Browser, enabling easy
identification:

Filtered

Press the Apply button to set the configured filters.



Controlling How Files Are Transferred
Yummy FTP controls file transferral using encoding and file replacement policies that are
completely customizable.

Encodings

There are several methods in which files are transferred using FTP: Binary, ASCII and
MacBinary. These are known as encodings and each file to be transferred may require a
different encoding in order for it to be successfully transferred. Each encoding is usually
used for specific types of files. For example, ASCII encoding would normally be used for
plain text files.

Choosing An Encoding

Each encoding can be selected manually, using the 'Encoding' option in the 'Transfer'
menu, This setting applies to all files transferred until the setting is changed.

The correct encoding for each file can be automatically chosen by Yummy FTP if the
'Automatic' option is chosen from the 'Transfer; menu. This is the default setting and
is recommended unless a manual override is required.

The Automatic encoding feature relies on the Suffix Mapping table, described below,
in order to determine encodings for various types of files. If a file does not transfer
correctly due to an incorrect automatic encoding selection, or a new file type needs to
be configured, the Suffix Mapping table can be edited to cater for this.

File Replacement

Since it is likely that one or more files to be transferred already exist or have the same
names in the destination, a file replacement policy must be used. This governs how these
situation should be dealt with, and can be selected using the 'Mode' option in the
'Transfer' menu. One of three policies may be chosen:

Obey Preferences Replacement Rules

This is the default policy and it presents a window which describes the two (or more)
files that match in the source and destination of a transfer, offering the choices to
replace or skip them. Additionally, if the destination file is of a lesser size than the



source file an option to resume the transfer will be given. This policy is configurable
in that the default behavior can be modified to always ask/replace/skip or resume (if
possible) and can be configured separately for uploads and downloads.

The default policy can be modified by editing the 'Upload Options' and 'Download
Options' within the 'Transfers' tab of the Preferences window, as shown below.

Preferences Window

Always Make Unique File Names

This policy is designed to avoid replacing files at all. Whenever a file to be transferred
already exists in the destination, the transferred file is assigned a unique name. This
option will affect both files on your Mac as well as on the Server.



Care should be taken with this option, since some servers are unable to process the
commands required to create uniquely named files. If this is the case, the Server will
usually report an error similar to 'Command not understood'.

Always Replace Files

Whenever a file to be transferred already exists in the destination, this policy will
always replace the file without warning. It should be used with care, but can be useful
if you are confident to do so.



Suffix Mapping

The Suffix Mapping table is used to determine which encoding to use for each file to be
transferred when Automatic encoding has been selected. It is also used to govern what
happens after a file has been downloaded, for example opening with Stuffit Expander to
expand an archive, and also to determine the icons of files that are displayed in the Server
browser.

To display the Suffix Mapping table, select the 'Suffix Mapping' option from the 'Transfer'
menu.

Suffix Mapping Window



How Mapping Works

Each entry in the Suffix Mapping table has four basic settings:

• File name suffix
• Mac OS file Type and Creator
• Encoding
• Apply to Uploads, Downloads, or Both

These settings are used to determine the correct encoding during transfers in the
following way:

Uploading

During uploads, only Suffix Mapping entries which are set for Uploads or Uploads and
Downloads are considered.

1) The Suffix Mapping table is scanned alphabetically from top to bottom to try to
find a matching file name suffix. If a match is found, the encoding setting in the
matched Suffix Mapping entry is used.

2) If no suffix match is found, or the file does not include a suffix, the Suffix Mapping
table is checked to find a match for the file's Mac OS Type and Creator. If a match is
found, the encoding setting in the matched Suffix Mapping entry is used.

3) If no match is found for either a suffix or the Mac OS Type and Creator, the file is
transferred using Binary encoding.

Each Suffix Mapping entry can be configured to add missing suffixes automatically.
This feature can be turned on or off for all entries regardless of their setting by using
the 'Add suffixes' checkbox in the Global settings area.

Each Suffix Mapping entry can be configured whether to consider the file's Mac OS
Type and Creator when determining the correct encoding. If this is not selected, step
2 of the decision process is skipped for the Suffix Mapping entry.

Downloading

During downloads, only Suffix Mapping entries which are set for Downloads or
Uploads and Downloads are considered.

1) The Suffix Mapping table is scanned alphabetically from top to bottom to try to



find a matching file name suffix. If a match is found, the encoding setting in the
matched Suffix Mapping entry is used.

2) If no suffix match is found, or the file does not include a suffix, the file is
transferred using Binary encoding. However, during the start of such a transfer,
Yummy FTP will determine whether the file data is a valid MacBinary format and will
automatically switch to MacBinary encoding is this is the case.

Each Suffix Mapping entry can be configured to post-process the file with an external
application, which is usually used with Stuffit archives or Disk Images to automatically
expand the downloaded file, or mount the disk image respectively. This feature can
be turned on or off for all entries regardless of their setting by using the 'Post-
process downloads' checkbox in the Global settings area.

File Icon and Kind Display

The Suffix Mapping table can also be used to determine the correct icon and file kind
to be associated with files displayed in the Server browser.

For each file that is added to the Server browser, the Suffix Mapping table is scanned
for a file name suffix match. If a match is found, the icon and file kind associated
with the file is set to that specified in the File Properties section of the entry.

If no match is found, the default icon and file kind used in the Finder is associated
with that file.

By default,  the Suffix Mapping table is not used for this information and the default
icon and file kind used in the Finder is associated with that file.

The 'Only use System mapping for icons' checkbox in the Global settings area controls
this behavior.

Remote Editor Association

The Suffix Mapping table provides a means of associating a particular file name
extension, such as .jpg, with a preferred editor application of your choice, for
example Graphic Converter. This is achieved by the use of the 'Use as default editor'
checkbox in the 'Downloading / Editing' pane of the suffix entry editor. The
screenshot shows an example of this.

To configure a particular suffix for editing with a particular application, select the
suffix entry in the list, press the Choose App button and locate the application. After



you have enabled the 'Use as default editor' checkbox, press the Save button.

Note that if there is more than one entry for a particular suffix then each one will
need to be configured the same way. Also note that the icon displayed next to the
chosen application may not be that of the application if 'Only use System mappings
for icons' is enabled.

Optional Mapping Techniques

Although the Suffix Mapping table offers a wealth of functionality and flexibility, it is
possible that the user has pre-configured the mapping table that is built into Mac OS
X. This table is inherited from the Internet Config (later known as Internet Control
Panel) settings from Mac OS 9. This table can be used instead of the one built into
Yummy FTP by selecting the 'Use System Preferences suffix mappings' checkbox
within the Global settings area. If this is chosen, all the Suffix Mapping functionality is
delegated to the OS supplied table instead.

Since there is no Apple provided user interface to modify the System Preferences
suffix mapping table, we recommend an application named 'MisFox' which will allow
this. The application is freeware and can be downloaded from the following URL:

http://www.clauss-net.de/misfox/misfox.html   

Modifying The Suffix Mapping Table

The Suffix Mapping table display is divided into two areas. The list of mappings is
displayed on the left and the settings for each mapping entry is displayed on the
right. Clicking on an entry in the list will display its settings on the right.

Modifying An Entry

Click on the entry to be modified in the list on the left, then adjust the settings
displayed to the right. When the modifications are complete, press the Save button on
the right. No modifications will be saved unless the Save button is pressed. To undo
any changes, press the Revert button.

Adding An Entry

Click on the Add button on the left. The suffix mapping settings area on the right will
all set empty. Configure the entry as required and then press the Save button to add
the new entry.

http://www.clauss-net.de/misfox/misfox.html


Deleting An Entry
Click on the entry in the list to be removed and then press the Remove button

Restoring Factory Settings

The Suffix Mapping table can be reverted to the settings that were set as default
when Yummy FTP was first installed by pressing the Defaults button on the left.



Further Information & Assistance
This Quick Start should get you up and running with Yummy FTP, however this document
does not cover all functionality in detail.

There are four avenues for further information regarding all the functionality and help with
using Yummy FTP.

Help Tips

Yummy FTP can display a Help Tip for each element of the user interface in every
window. The tips are very brief but descriptive and are likely to answer whatever
questions you may have.

To enable the Help Tips, select the 'Show Help Tips' option in the 'Help' menu and
then leave your mouse pointing at the item of interest for a second or two. The Help
Tip window will then be displayed. To hide the Help Tips again, select the 'Hide Help
Tips' option from the 'Help' menu.

User Guide

The User Guide for Yummy FTP is available online in the form of a Wiki - a database
which we are constantly updating with the latest information about all aspects of
using the software. It is a useful reference for getting the most out of Yummy FTP and
is recommended for all users. The Yummy FTP User Guide Wiki can be viewed from
our web site:

http://www.yummysoftware.com/documentation    
Forum

The Yummy FTP User Forum is a message board in which the developers and users of
Yummy FTP can post any topics relating to the software. The forum is public, so all
are welcome to join and post to it.

By joining the forum you'll get help and advice from other Yummy FTP users and, of
course, our Technical Support staff, plus you may make feature requests, report
bugs, or discuss any matter relating to Yummy FTP or Yummy Software. Enter the
following url into your web browser to visit:

http://www.yummysoftware.com/forum     

http://www.yummysoftware.com/documentation
http://www.yummysoftware.com/forum


Technical Support

Our technical support team are ready to answer your questions or help you with any
problem you might encounter. All users are entitled to free technical support via
email:

mailto:support@yummysoftware.com     

If you are having a problem, please try to describe it as fully as you can. This will help
us to resolve the problem as quickly as possible. In any case, whether you have a
technical problem or a question, you should expect a reply from us within two days,
usually sooner.

Web Site

We will be constantly updating our web site with the latest news about Yummy FTP.
Be sure to visit.

http://www.yummysoftware.com     
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